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Getting Started  

Before using e-VU Express (Capture), please take the time to read through this guide and 

familiarise yourself with the controls and features available to you.  The guide itself is structured 

so that it can be read from beginning to end or as a quick reference for specific actions/features.   

 

LŦ ȅƻǳ ƘŀǾŜƴΩǘ ŀƭǊŜŀŘȅ ƛƴǎǘŀƭƭŜŘ e-VU Express, or you are having difficulties installing e-VU 
ExpressΣ ǇƭŜŀǎŜ ǊŜŦŜǊ ǘƻ ǘƘŜ ΨŜ-±¦ 9ȄǇǊŜǎǎ оΦр Lƴǎǘŀƭƭŀǘƛƻƴ DǳƛŘŜΩ ŦƻǊ ŘŜǘŀƛƭǎ ƻƴ Ƙƻǿ ǘƻ 
install the software.  If you are still having trouble installing the software, please refer to 
the Notices chapter on ways to contact Intelligent Filing for further assistance. 

 

No specialist knowledge is required to use e-VU Express (Capture) as all features and functions are 

covered in detail within this documentation, you will need at least a basic understanding of the 

Microsoft Windows desktop operating system to be able to use the software to its fullest. 

About e-VU Express 

The e-VU Express software is a document archive creation program, designed and developed by 

Intelligent Filing.  The purpose of the software is to provide a low cost, feature rich solution to the 

problems associated with archiving paper documents, which is also suitable for all sizes of 

business from sole trader to large enterprises. 

 

Based on the award winning e-VU Professional software, e-VU Express has at its centre, the basic 

building blocks of a document management system.  By using only the core principles of scan, 

store and retrieve, e-VU Express is an effective archiving utility which allows the archiving of 

documents to CD, DVD and flash drives.   

 

This effective tool can be used to help reduce the unnecessary clutter caused by storing historical 

paper records.  Where documents have to be retained (legal, medical etc) it can be used to create 

άƭƻŎŀƭέ ŜƭŜŎǘǊƻƴƛŎ ŎƻǇƛŜǎ ƻŦ ǘƘƻǎŜ ŘƻŎǳƳŜƴǘǎΣ ǿƘƛƭŜ ǘƘŜ ƻǊƛƎƛƴŀƭ ŘƻŎǳƳŜƴǘǎ Ŏŀƴ ōŜ put into 

document storage ς freeing up space and ensuring easier, faster access to the records in the 

event of an enquiry. 

e-VU Express Modules 

The e-VU Express software actually comprises of two modules, Capture and Retrieve; this 

documentation is specifically for the Capture module. 

 

 

 

http://www.intelligentfiling.com/products/software/evu_document_management/
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e-VU Express (Capture) 

¢ƘŜ ŎŀǇǘǳǊŜ ƳƻŘǳƭŜ ƛǎ ǊŜǎǇƻƴǎƛōƭŜ ŦƻǊ ǇŜǊŦƻǊƳƛƴƎ ǘƘŜ άŎŀǇǘǳǊƛƴƎέ ƻŦ ȅƻǳǊ ŘƻŎǳƳŜƴǘǎ ǘƻ 

CD/DVD/flash drive either from files that already exist on your computer, or by scanning paper 

documents with your document scanner.  A shortcut is added to your start menu for this module 

during the e-VU Express installation.  

Software Licensing  

e-VU Express is installed with a 10 day evaluation license.  During this time, you may use the 

program as much as you wish, without any restrictions.  After this time, you must either purchase 

a license key from Intelligent Filing, or uninstall the program.  Software licensing within e-VU 

Express is as straight forward as the program itself, you purchase a license for each workstation 

that you wish to install the software on and any additional support/maintenance options and 

ǘƘŀǘΩǎ ƛǘ.   

 

Archives created during the evaluation period are yours to keep and use unrestricted, even after 

the evaluation period for the main program has expired. 

 

Check http://www.intelligentfiling.com/  for the most up to date license costs including any 
special offers.  Registered charities are entitled to the software for free; check the web site 
for terms and conditions. 

 

Starting e-VU Express (Capture)  

If you have installed e-VU Express to its default location, you can start the capture program by 

following these instructions: 

 

1. Click Start 

2. Select the All Programs menu item from the Windows Start Menu 

3. Select the e-VU Document Management start menu folder 

4. Click e-VU Express 

 

 If you selected a different start menu folder when e-VU Express was installed, select that folder in 

step three above instead. 

 

If this is your first time using e-VU ExpressΣ ȅƻǳΩƭƭ Ƴƻǎǘ ǇǊƻōŀōƭȅ ǿŀƴǘ ǘƻ explore the program to 

find out what all the buttons and things are for. 

 

http://www.intelligentfiling.com/
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Exploring the Program  

On starting e-VU Express (Capture) you will be presented with the initial program window (shown 

below).  The programΩs features are grouped in three distinct areas, the main menu, the toolbar 

and the document viewer. 

 

 

The Main  Menu 

File Menu 

The File menu consists of five items.  The first of these, Create Batch is used to start the capturing 

ǇǊƻŎŜǎǎΣ ŎƭƛŎƪ ǘƘƛǎ ƛǘŜƳ ǿƘŜƴ ȅƻǳΩǊŜ ǊŜŀŘȅ ǘƻ ŎǊŜŀǘŜ ŀ ōŀǘŎƘ ǳǎƛƴƎ ŜȄƛǎǘƛƴƎ ƻǊ ǎŎŀƴƴŜŘ ŘƻŎǳƳŜƴǘǎΦ  

After you have created a batch and captured some documents, the Append Batch menu item 

becomes active.  If you wish to add further documents, you click this menu item.  Still continuing 

the batch theme for the menu items is Save BatchΦ  ²ƘŜƴ ȅƻǳΩǊŜ ŘƻƴŜ ŀŘŘƛƴƎ ŀƭƭ ƻŦ ȅƻǳǊ 

ŘƻŎǳƳŜƴǘǎ ǘƻ ǘƘŜ ōŀǘŎƘΣ ȅƻǳΩƭƭ ƴŜŜŘ ǘƻ ŎƭƛŎƪ Save Batch to begin the final stage of processing 

which is actually the part where your documents get burned to CD/DVD or copied over to your 

flash drive. 

 

LŦ ȅƻǳΩǾŜ ōŜŜƴ ǎŎŀƴƴƛƴƎ ǘƘŜ ǿǊƻƴƎ ŘƻŎǳƳŜƴǘǎΣ ȅƻǳ Ŏŀƴ ǊŜƳƻǾŜ ǘƘŜ ǇŀƎŜǎΣ ōǳǘ ǘƘŜ ŦŀǎǘŜǎǘ ǿŀȅ ǘƻ 

get back on track is to start over with a new ōŀǘŎƘΦ  ¢ƻ Ǝƻ ōŀŎƪ ǘƻ ǘƘŜ άōƭŀƴƪ ŎŀƴǾŀǎέ ƻŦ      e-VU 

Express, click Cancel BatchΣ ȅƻǳΩƭƭ ǎŜŜ ǎƻƳŜ ƳŜǎǎŀƎŜ ōƻȄŜǎ ǿƘŜƴ ȅƻǳ ŎŀƴŎŜƭ ŀ ōŀǘŎƘΣ 

acknowledge these and things go back to the way they were. 
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Finally, we have Exit.  This will close down e-VU Express (Capture), if you have already started a 

batch, you will need to confirm the message boxes in order to close the program.  These 

messages are the same as if you were cancelling a batch. 

Help Menu 

The Help menu is home to six menu items all related to helping you, the end user, get the most 

ŦǊƻƳ ǘƘŜ ǇǊƻƎǊŀƳ ŀƴŘ ǇƻƛƴǘƛƴƎ ȅƻǳ ƛƴ ǘƘŜ Ƴƻǎǘ ŘƛǊŜŎǘ ǊƻǳǘŜ ǘƻ ǘƘŜ ŀƴǎǿŜǊǎ ǿƘŜƴ ȅƻǳΩǊŜ ƴƻǘΦ  ¢ƘŜ 

first menu item e-VU Express Help is the in-program link to this document, with a couple of clicks 

you can easily find the hŜƭǇ ȅƻǳ ƴŜŜŘΣ ŜǎǇŜŎƛŀƭƭȅ ǳǎŜŦǳƭ ǿƘŜƴ ȅƻǳ ƘŀǾŜ ƻƴŜ ƻŦ ǘƘƻǎŜ άōƭŀƴƪέ 

moments.  The second item in this menu is e-VU Express Online.  Clicking this item will start your 

default web browser and (internet connection permitting) take you to the e-VU Express home 

page on www.intelligentfiling.com.   

 

{ƻƳŜǘƛƳŜǎΣ ƛǘΩǎ Ƨǳǎǘ ŜŀǎƛŜǊ ǘƻ ŀǎƪ ǎƻƳŜƻƴŜ Ƙƻǿ ȅƻǳ Řƻ something or how to overcome a 

problem, and although we try and keep our documentation and FAQ up to date, sometimes the 

ŀƴǎǿŜǊǎ ǘƻ ǎƻƳŜ ǇǊƻōƭŜƳǎ ǿƻƴΩǘ ŀƭǿŀȅǎ ōŜ ǘƘŜǊŜ όƧǳǎǘ ȅŜǘύΦ  bŜǾŜǊ ŦŜŀǊΣ ƻǳǊ ǎǳǇǇƻǊǘ Ǝǳȅǎ ŀǊŜ 

here and by clicking the Contact Support ƭƛƴƪΣ ȅƻǳΩƭƭ ǎŜŜ ŀ ƴŜǿ ŜƳŀƛƭ ǿƛǘƘ ǘƘŜ ŀŘŘǊŜǎǎ ŘŜǘŀƛƭǎ 

already pre-populated.  Type your query or question, hit send aƴŘ ǿŜΩƭƭ ƎŜǘ ōŀŎƪ ǘƻ ȅƻǳ !{!t. 

 

For evaluation users, our target time for initial response is 24 hours, but during busy 
periods, this can take up to 48 hours.  For our licensed customers with support and 
ƳŀƛƴǘŜƴŀƴŎŜ ǇŀŎƪŀƎŜǎΣ ȅƻǳǊ {[!Ωǎ ŀǊŜ ŘŜǘŀƛƭŜŘ ƛƴ your contract. 

 

Our developers are hard at work making sure e-VU Express ƛǎ ōǳƎ ŦǊŜŜ ŀƴŘ Ŝŀǎȅ ǘƻ ǳǎŜΣ ōǳǘ ǘƘŀǘΩǎ 

no good if you have to keep visiting our web site to see if there are any new versions of the 

program to download.  This is where Check for Updates comes in.  If you have an internet 

connection, clicking this link will start the Checking for Updates process. 

 

The penultimate item in the Help menu is License Information.  By selecting this item from the 

Help menu, you can see how the program thinks it is licensed.  When e-VU Express is running in 

ǿƛǘƘ ŀƴ ŜǾŀƭǳŀǘƛƻƴ ƭƛŎŜƴǎŜΣ ǘƘŜ ƭƛŎŜƴǎŜ ǎŎǊŜŜƴ ǿƛƭƭ ŘƛǎǇƭŀȅ ά9ǾŀƭǳŀǘƛƻƴέΣ ǿƘŜƴ ǘƘŜ ǇǊƻƎǊŀƳ Ƙŀǎ 

been registered, you will see a screen similar to the one shown below.  When you purchase a 

license for e-V¦ 9ȄǇǊŜǎǎΣ ȅƻǳΩƭƭ ƴŜŜŘ ǘƻ ǳǇŘŀǘŜ ȅƻǳǊ ƭƛŎŜƴǎŜ ƛƴŦƻǊƳŀǘƛƻƴ ǘƻ ǊŜƳƻǾŜ ǘƘŜ ŜǾŀƭǳŀǘƛƻƴ 

restriction. 

 

http://www.intelligentfiling.com/
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And finally from the Help menu; the obligatory About item.  Clicking this item displays the About 

screen (shown below).  The information contained on the first tab can be helpful to our support 

Ǝǳȅǎ ƛŦ ȅƻǳ ƴŜŜŘ ǘƘŜƛǊ ƘŜƭǇ ŘƛŀƎƴƻǎƛƴƎ ŀ ǇǊƻōƭŜƳΣ ƛǘΩǎ ƴƻǘ Ŝŀǎȅ ƎŜǘǘƛƴƎ ŀǘ ǘƘƛǎ ƛƴŦƻǊƳŀǘƛƻƴ 

ƴƻǊƳŀƭƭȅΣ ǎƻ ǿŜΩǾŜ Ǉǳǘ ƛǘ ƘŜǊŜ ŦƻǊ ȅƻǳǊ ōŜƴŜŦƛǘΦ  hƴ ǘƘŜ About screen, you can also find the e-VU 

Express license agreement, sƘƻǳƭŘ ȅƻǳ ƴŜŜŘ ǘƻ ǊŜŦŜǊ ǘƻ ƛǘΣ ŀƴŘ LƴǘŜƭƭƛƎŜƴǘ CƛƭƛƴƎΩǎ ŎƻƴǘŀŎǘ 

information for quick reference. 
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The Toolbar  

On the toolbar, you will find four buttons, Create Batch, Append Batch, Save Batch and Cancel 

Batch.  The toolbar is shown below as it appears part way through a batch, with Append Batch, 

Save Batch and Cancel Batch all active and Create Batch inactive.   

 

 
 

Each button is cunningly named after an entry in the File menu, and, not surprisingly, each does 

the same job.  Why?  Because some people prefer buttons, some prefer menu items, and as we 

want e-VU Express ǘƻ ōŜ Ŝŀǎȅ ǘƻ ǳǎŜ ŦƻǊ ŜǾŜǊȅƻƴŜΣ ǿŜΩǊŜ ǇǊƻǾƛŘƛƴƎ ŦǳƴŎǘƛƻƴǎ ŦƻǊ ŜǾŜǊȅƻƴŜΦ  

Another great reason for buttons, ƛǎ ŦƻǊ ǘƘƻǎŜ ǘƘŀǘ ƘŀǾŜ ǘƻǳŎƘ ǎŎǊŜŜƴǎ όȅŜǎΣ ȅƻǳ ƭǳŎƪȅ ŦŜǿύ ȅƻǳΩƭƭ 

find it much easier to prod at the button, than select an item from the menu. 

The Document Viewer  

The document viewer allows you to see what you have captured (from either scanning or 

importing documents or even a combination of the two) through its extra large main window and, 

when you capture many pages, you will also see thumbnails for all of the pages, allowing you to 

jump to a specific page quickly.  The document viewer (mid batch) is shown below. 

 

 

30/11/2008 

 

Fire Alarm Test Schedule 

 
With immediate effect, the weekly fire alarm test will be scheduled for Wednesday mornings at 10:30am. 

 

Please ensure all visitors are aware of the fire procedure. 
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In addition to the thumbnails, the document viewer also provides a whole host of tools from 

simple navigation to page rotation and deletion, helping you to create the perfect batch every 

time.  These tools are explained below.  

Document Viewer Toolbar 

Page Navigation 

From the document viewer toolbar, you are able to move through multi-page documents a page 

at a time, view the page count for the document and the current page being viewed.   

 

 
 

Page and Document Rotation 

You can also perform clockwise and counter-clockwise rotation of the current document on a 

page by page or whole document basis. 

 

 
By pressing and holding the downward facing arrows of the rotation buttons, it is possible to 

rotate all pages in the current batch. 

 

 
 

 
 

Display Size 

It is possible to alter how the page you are viewing is displayed on the screen by utilising the 

Zoom Presets.  By selecting the different items from this list, the displayed image will either grow 

or shrink.   

 

 
 

The three buttons which immediately follow the Zoom Presets are Zoom, Pan and Selection 

respectively and they are also used to alter how the document is displayed.  Zoom makes it 

possible to zoom into and out of a document using the left and right mouse buttons.  When 

selected, Pan allows documents to be dragged around so that portions of the document not being 

displayed can be visible.  Finally Selection allows the placement of a rectangular marker on the 
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screen.  On releasing the mouse button, the preview window will zoom into the screen where the 

marker was drawn. 

 

Zoom, Pan and Selection are selectable and must be turned on and off.  Turning on one of 
the features automatically turns off a feature that was selected previous.  To return a 
document preview to its original size, select Best Fit from the Zoom Presets. 
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Capturing Your Documents  

Its all well and good describing the features ƻŦ ǘƘŜ ǇǊƻƎǊŀƳ ƛƴ ƎǊŜŀǘ ŘŜǘŀƛƭΣ ōǳǘ ǿŜ ŀƭƭ ƪƴƻǿ ǿƘŀǘΩǎ 

really needed is step by step instructions on how to use all this nice technology to make 

document archiving a breeze. 

 

²Ŝƭƭ ōŜŦƻǊŜ ǿŜ ƧǳƳǇ ǊƛƎƘǘ ƛƴΣ ǘƘŜǊŜΩǎ ǘƘŜ ƭƛǘǘƭŜ ǎǳōƧŜŎǘ ƻŦ ǘŜǊƳƛƴƻƭƻƎȅΦ  Throughout this guide, 

you'll see the term batches mentioned quite considerably, and you may be thinking what does it 

mean?  Well, we (Intelligent Filing) in the context of e-VU Express, use the term batch to refer to a 

document or collection of documents that have been captured at the same time.   

 

Before you start to archive your documents off, please take care when deciding how to 
capture the documents in the first place.  During the capture process, e-VU Express will see 
every page as just that, a single page.  The software is not aware of your document 
structures i.e. when one document starts and another ends.   

 
If you are using a document scanner, you can add blank pages between your documents 
and when you come to save the batch, you can set the option to use blank page 
ǎŜǇŀǊŀǘƛƻƴΦ  ¢Ƙƛǎ ƛǎ Ƴƻǎǘ ǳǎŜŦǳƭ ǿƘŜƴ ȅƻǳǊ ŘƻŎǳƳŜƴǘǎ ŀƭƭ ǾŀǊȅ ƛƴ ǇŀƎŜ ƭŜƴƎǘƘΦ  ²ƘŜƴ ȅƻǳΩǊŜ 
dealing with fixed page lengths, you can specify the number of pages you are working with 
during the save process.  Alternatively, you can create a great big single page document 
from everything you have scanned, which may not sound that practical, but it does have its 
uses.   

 

Creating a Batch 

Now that we have the terminology ƻǳǘ ƻŦ ǘƘŜ ǿŀȅΣ ƛǘΩǎ ǘƛƳŜ ǘƻ ƎŜǘ Řƻǿƴ ǘƻ ōǳǎƛƴŜǎǎ.  To create a 

new batch, follow these steps: 

 

1. From the Toolbar, click Create Batch (or you could select Create Batch from the File 

menu) 

 

 
 

2. You will then see a screen which asks you to select where you will be capturing your 

documents from (the document source).  If you will be using your document scanner i.e. 

capturing real paper documents, you need to select the first option.  If the documents 

ŀƭǊŜŀŘȅ ŜȄƛǎǘ ƻƴ ȅƻǳǊ ŎƻƳǇǳǘŜǊΣ ǎŜƭŜŎǘ ǘƘŜ ǎŜŎƻƴŘ ƻǇǘƛƻƴΦ  hƴŎŜ ȅƻǳΩǊŜ ŘƻƴŜΣ ŎƭƛŎƪ hY 
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LŦ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ ŀ ŘƻŎǳƳŜƴǘ ǎŎŀƴƴŜǊ ŀǘǘŀŎƘŜŘ ǘƻ ȅƻǳǊ ŎƻƳǇǳǘŜǊΣ ȅƻǳ ǿƛƭƭ ƴƻǘ ōŜ 
ŀōƭŜ ǘƻ ǎŜƭŜŎǘ ά{Ŏŀƴ ŘƻŎǳƳŜƴǘǎ ǳǎƛƴƎ ŀ ¢²!Lb ŎƻƳǇŀǘƛōƭŜ ǎŎŀƴƴŜǊέ ŀǎ ƛǘ ǿƛƭƭ ōŜ 
disabled. 

 

3. What happens next depends on the option you selected in step 2: 

 

 If you selected 

 

a. Scan documents using a TWAIN compatible scanner 

The scanner selection screen will appear, allowing you to select the document 

scanner you wish to use during this process.  Choose the document scanner you 

wish to use and click Select. 

 

 
 

You will now see the document scanner control screen.  This will vary 

depending on the document scanner you have and you will need to consult with 

your document scanner documentation if you are unfamiliar with what you see 

on the screen.   

 

e-VU Express supports ŀ ŦŜŀǘǳǊŜ ŎŀƭƭŜŘ άōƭŀƴƪ ǇŀƎŜ ǎŜǇŀǊŀǘƛƻƴέΦ  ²Ƙŀǘ 
this means is that if you insert a blank sheet of paper between the 
documents that you are scanning and you select the correct option when 
you save the batch, the documents will retain their structure. 

 

Use the document scanner control screen to capture your paper documents.  

When you are finished, you can carry on to step 4. 

 

If you selected  
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b. Import files from the hard drive of the computer 

¸ƻǳΩƭƭ ǎŜŜ ŀ ǎŎǊŜŜƴ ǿƘŜǊŜ ȅou can browse your computer, and select the 

document or documents (hold down the Ctrl key while clicking to select 

multiple documents) that you wish to add to your new batch. 

 

¸ƻǳ Ŏŀƴ ǎŜƭŜŎǘ ŀƴȅ άƛƳŀƎŜέ ǘȅǇŜ ŦƛƭŜǎ ǘƘŀǘ ƘŀǾŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ŦƛƭŜ ŜȄǘŜƴǎƛƻƴǎ ǘƻ 

create your batch: 

 

JPEG, JPEG EXIF, PNG, PNM, TIFF, TIFF G3/G4 Fax, PCX, TGA, BMP, PSD, PCD, 

GIF, EXIF, WMF/EMF 

 
 

When you have selected your documents, click OpenΦ  ¸ƻǳΩƭƭ ƴƻǿ ōŜ ŀōƭŜ ǘƻ 

continue following the main instructions at step 4 

 

4. Regardless of which method you selected to capture your documents, once the process 

is complete, you will be returned to e-VU Express (Capture) and the screen will look 

something like the image below.  From here, you can either append more pages to the 

batch or save the batch 

 

 

 

 



 

 

14 e-VU Express (Capture) 3.5 

User Guide - Page 14 of 25 

 

Appending Pages to a Batch 

The ability to append documents to a batch is only available when a batch is in progress i.e. you 

have created a new batchΦ  hƴŎŜ ȅƻǳΩǊŜ ǘƘƛǎ ŦŀǊΣ ȅƻǳ Ŏŀƴ Ŧƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎ ǘƻ ŀǇǇŜƴŘ ƳƻǊŜ ǇŀƎŜǎ 

to the batch. 

 

1. From the Toolbar, click Append Batch (or you could select Append Batch from the File 

menu) 

 

 
 

2. LŦ ȅƻǳΩǾŜ ōŜŜƴ ǊŜŀŘƛƴƎ ŎƭƻǎŜƭȅΣ ȅƻǳΩƭƭ ǎŜŜ ǘƘŜ ǎŀƳe screen from when you created your 

batchΦ  ¢ƘŀǘΩǎ ōŜŎŀǳǎŜΣ ƻƴŎŜ ǘƘŜ ƛƴƛǘƛŀƭ ǘŀǎƪ ƻŦ ǘŜƭƭƛƴƎ e-VU Express you wish to append 

pages is over, the process is exactly the same as that set out in Creating a Batch (from 

ǎǘŜǇ н ƻƴǿŀǊŘǎύΦ  LŦ ȅƻǳΩǾŜ ŦƻǊƎƻǘǘŜƴ ǿƘŀǘ ǘƻ Řƻ ŀǘ ǘƘƛǎ ǇƻƛƴǘΣ Ƨǳǎǘ ǊŜ-read the previous 

ŎƘŀǇǘŜǊΣ ŀƴŘ ǿƘŜƴ ȅƻǳΩǊŜ ŘƻƴŜ ŎŀǇǘǳǊƛƴƎ ȅƻǳǊ ŘƻŎǳƳŜƴǘǎ ȅƻǳΩƭƭ ŦƛƴŘ ȅƻǳǊǎŜƭŦ ƘŜǊŜ ŀǘ 

step 3 

 

3. There we have it, more pages appended to the batch.  From here, you can either 

append more pages to the batch or save the batch 

 

Saving a Batch 

{ƻ ǘƻ ǘƘŜ ƘƻƳŜ ǎǘǊŀƛƎƘǘΣ ȅƻǳΩǾŜ created your batch, and you may have even appended more 

ǇŀƎŜǎ ǘƻ ǘƘŜ ōŀǘŎƘ ŀǎ ǿŜƭƭΣ ōǳǘ ŀǎ ƛǘ ǎǘŀƴŘǎΣ ƛǘΩǎ ƴƻ ƳƻǊŜ ǳǎŜŦǳƭ ǘƘŀƴ ǿƘŀǘ ȅƻǳ ǎǘŀǊǘŜŘ ǿƛǘƘΣ ǿƘŀǘ 

do you need to do?  Save the batch, and here is how you do it: 

 

1. From the Toolbar, click Save Batch (or you could select Save Batch from the File menu) 

 

 
 

2. bƻǿΣ ȅƻǳΩƭƭ ǎŜŜ ǘƘŜ {ŀǾŜ .ŀǘŎƘ ǎŎǊŜŜƴ όǎƘƻǿƴ ōŜƭƻǿύΦ  Lǘ Ƴŀȅ ƭƻƻƪ ŀ ōƛǘ ŘŀǳƴǘƛƴƎ ŀǘ ŦƛǊǎǘ 

glŀƴŎŜΣ ōǳǘ ŜŀŎƘ ΨǎǘŜǇΩ ƛǎ ǎŜƴǎƛōƭȅ ƎǊƻǳǇŜŘ ǘƻƎŜǘƘŜǊ ǘƻ ƳŀƪŜ ǘƘƛǎ ǎǘŀƎŜ ŀǎ Ŝŀǎȅ ŀǎ 

creating a batch is 

 

 

 



 

 

15 e-VU Express (Capture) 3.5 

User Guide - Page 15 of 25 

 

 
 

3. ¢ƘŜ ŦƛǊǎǘ άƎǊƻǳǇέ ƻƴ ǘƘŜ ǎŎǊŜŜƴΣ ƛǎ ǘƘŀǘ ƻŦ Batch Description.  You can think of this as a 

label for the batch contents.  If you leave Use Default Description checked, the batch 

will be labelled with just the current date and time, which may be all that you need, but 

if you un-tick this option, you can specify a more meaningful ŘŜǎŎǊƛǇǘƛƻƴ ǎǳŎƘ ŀǎ Ψ!ǳƎǳǎǘ 

LƴǾƻƛŎŜǎΩΣ ΩCŀȄŜǎΩΣ ΨHR Records 07Ω ŜǘŎ   
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4. ¢ƘŜ ǎŜŎƻƴŘ ƻŦ ƻǳǊ άƎǊƻǳǇǎέ ƛǎ Batch Destination, and just like the name implies, this is 

ǿƘŜǊŜ ǘƘŜ ōŀǘŎƘ ǎƘƻǳƭŘ ōŜ ǿǊƛǘǘŜƴ ǘƻΦ  !ǎ ȅƻǳΩƭƭ ǎŜŜ ȅƻǳ, have two clear options; optical 

i.e. CD/DVD and Flash Devices i.e. USB flash drives, SD cards etc.  The option you select 

affects what happens next 

 

If you select 

 

a. CD or DVD Media 

 

i. From the drop down list of detected CD or DVD writers, select the 

device that you will be putting your blank media into to finish creating 

your archive 

 

 
 

If you select 

 

b. Flash Memory Device (USB Key) 

 

i. Click the Browse button 

 

 
 

ii. Select the device (and optionally a folder) where you want to save your 

batch to and click OK 
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iii. The path you selected will now be shown in the main screen 

 

 
 

5. Configuring the save batch steps is almost over now, the final stage is selecting the 

Document Processing options.  This penultimate step determines how the pages will be 

saved within the archive itself and whether the documents can be searched using the 

full text search system of e-VU Express (Retrieve).  These options were mentioned at the 

beginning of this chapter, but to recap: 

 

a. Create a single document from all scanned pages 

By selecting this option, what you are telling the software is simply for 

everything I have captured, make one big document.  This can be useful if 

ȅƻǳΩǊŜ collating several smaller documents into one such as a financial report. 

 

b. Create a new document every time a blank page is detected 

.ȅ ǎŜƭŜŎǘƛƴƎ ǘƘƛǎ ƻǇǘƛƻƴΣ ȅƻǳΩǊŜ ŀǎƪƛƴƎ ǘƘŜ ǎƻŦǘǿŀǊŜ ǘƻ ŘŜǘŜŎǘ ƛŦ ŀ ǇŀƎŜ Ƙŀǎ ƴƻ 

text on it, and if so, it should start to create a new document from the 

ǊŜƳŀƛƴƛƴƎ ǇŀƎŜǎΦ  ¢Ƙƛǎ ƛǎ ƪƴƻǿƴ ŀǎ ŘƻŎǳƳŜƴǘ ǎŜǇŀǊŀǘƛƻƴΣ ŀƴŘ ƛǎ ǳǎŜŦǳƭ ƛŦ ȅƻǳΩǊŜ 

archiving original documents that you wish to keep the structure of and they 

have a varying number of pages in 

 

c. Create a new document every N pages 

Although this sound quite technical, it is a very simple option to understand, the 

N in the caption refers to a number, which you can set in the value list 

immediately below the option, so, for example, if you select 2, a new document 

will be created in your archive every two pages ς or to put it another way, each 

ŘƻŎǳƳŜƴǘ ǿƛƭƭ ōŜ ǘǿƻ ǇŀƎŜǎ ƭƻƴƎΦ  ¸ƻǳΩƭƭ ŦƛƴŘ ǘƘƛǎ ǳǎŜŦǳƭ ǿƘŜƴ ȅƻǳΩǊŜ ŀǊŎƘƛǾƛƴƎ 

off documents which have a fixed page length, such as invoices, faxes, reports 

etc 

 

 
 

The last thing to consider with the Document Processing options, determines how you 

will be able to find your documents in the archive.  Perform Full Page OCR indicates to 

ǘƘŜ ǇǊƻƎǊŀƳ ǘƘŀǘ ǿƘŜƴ ƛǘ ƛǎ ŎǊŜŀǘƛƴƎ ȅƻǳǊ ŀǊŎƘƛǾŜΣ ƛǘ ǎƘƻǳƭŘ ŀƭǎƻ άǊŜŀŘέ ǘƘŜ ǘŜȄǘ ŦǊƻƳ 

each page and store it so that you can perform word searches with     e-VU Express 
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(Retrieve) ƛƴ ƻǊŘŜǊ ǘƻ ƭƻŎŀǘŜ ŘƻŎǳƳŜƴǘǎ ƛƴ ȅƻǳǊ ŀǊŎƘƛǾŜ ǉǳƛŎƪƭȅΦ  LŦ ȅƻǳΩǊŜ ƴƻǘ ǎǳǊŜ 

whether you need this or not, our recommendation is to leave it tickeŘΤ ȅƻǳ ŘƻƴΩǘ ƘŀǾŜ 

ǘƻ ǳǎŜ ǘƘŜ ǎŜŀǊŎƘ ŦǳƴŎǘƛƻƴǎ ǘƻ ƭƻŎŀǘŜ ȅƻǳǊ ŘƻŎǳƳŜƴǘǎΣ ōǳǘ ȅƻǳ ŎŀƴΩǘ ŎƻƳŜ ōŀŎƪ ǘƻ ŀƴ 

ŀǊŎƘƛǾŜ ŀŦǘŜǊ ƛǘ Ƙŀǎ ōŜŜƴ ǿǊƛǘǘŜƴ ŀƴŘ ŀŘŘ ǘƘŜ άǊŜŀŘέ ƛƴŦƻǊƳŀǘƛƻƴ ǘƻ ƛǘΦ 

 

6. So, with everything set, just press OK, and watch as e-VU Express (Capture) archives 

your documents 

 

 
 

Please be patient at this stage, the OCR process can take a long time, and is 
dependent on several factors such as word count per page, page structure and 
font size. 

 

7. When the process completes, you will be asked the following question.  If you want to 

start over, with no pages loaded into e-VU Express (Capture), click Yes, if you click No, 

you can always select Cancel Batch from the Toolbar if you change your mind 
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Retrieving Your Documents  

Several times throughout this document, you will have seen e-VU Express (Retrieve), but what is 

it?  Well, e-VU Express (Retrieve) is a lightweight standalone program that is added to each 

archive you create and it is this program that provides easy to use features for searching your 

archives. 

 

e-VU Express (Retrieve) has its own user guide because it is not directly usable from within     e-VU 

Express (Capture)Φ  ¸ƻǳ ǎƘƻǳƭŘ ƘŀǾŜ ǎŜŜƴ ǘƘŜ ǎƘƻǊǘŎǳǘ ǘƻ άŜ-VU Express (Retrieve) ς User DǳƛŘŜέ 

in your start menu, this is the place to start getting assistance using the program.  The user guide 

is also distributed with each archive you create, so you know help is only a click away. 
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Program  Maintenance  

Checking for Updates  

As we described in ǘƘŜ ŎƘŀǇǘŜǊ άExploring the ProgramέΣ ƛǘ ƛǎ ǇƻǎǎƛōƭŜ ǘƻ ǳǇŘŀǘŜ ǘƘŜ e-VU Express 

software from within the program itself, saving you the time and effort involved in remembering 

to visit our web site for updates.   

 

Only the Capture module of e-VU Express can perform an automatic update.  Although this 
will update versions of the Retrieve module that are written to CD/DVD or flash drives 
following the update, previous archives will not be updated.  

 

To update the program, follow the steps below: 

 

1. From the Help menu, click Check for Updates 

 

 
 

 

2. If there is an update available, you will see the following message box, click Yes to 

download the update 

 

 
NB: Clicking No will halt the update process; you will need to start from step 1 again to attempt to update the program 

 

 

 



 

 

21 e-VU Express (Capture) 3.5 

User Guide - Page 21 of 25 

 

 

3. Select the folder where you would like the update to be downloaded to and click OK 

 

 
 

4. e-VU Express will now be downloaded to the folder you selected in the previous step 

 

 
 

5. When the download is complete, you will be asked if you wish to run the update now.  

Click Yes to install the update.  e-VU Express will then close, and the installation 

program will begin.  This is the same process as described in the ΨŜ-VU Express 3.5 

Lƴǎǘŀƭƭŀǘƛƻƴ DǳƛŘŜΩ 
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If you click No at this point, the update will not proceed but e-VU Express will be aware 
that an update has been downloaded.  The next time you start e-VU Express, you will be 
asked if you wish to perform the update.  If you click No again, the download will be 
deleted and you will need to perform the Check for Updates process again. 

 

Updating License Information  

Should you choose to purchase a license for e-VU Express, you will need to update your 

evaluation license in order to continue using the program.   To update your license, follow the 

steps below: 

 

1. When you receive your email from Intelligent Filing with the license key attached, save 

the file to your computer.  Remember the location as you will need to find the file in 

step 3 

 

2. From the Help Menu, click License Information 

 

 
 

3. From the License Manager screen, click Browse 
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4. Browse your computer to find the e-VU Express.info file that you saved in step 1, select 

it and click Open 

 

 
 

5. When you are back in the License Manager screen, click Install 

 

 
 

6. You will receive a confirmation message if the installation of your license is successful.  

Click OK to close the message 

 

 
 

 


